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ANEXO 1. CONFIGURACIÓN DEL PROGRAMA NI-
MATE 

Para configurar el equipo antes de ejecutar la aplicación, en primer lugar hay que abrir 
el programa Delicode Ni-mate 2. 

     
IMAGEN 1: ICONO DEL PROGRAMA NI-MATE 2, VERSIÓN ESCRITORIO (IZQ) Y VERSIÓN BARRA DE 

NOTIFICACIONES (DER). 

Una vez abierto, aparecerá el icono en la barra de notificaciones, pulsar click + 
izquierdo del ratón sobre él y seleccionar Control interface. 

 
IMAGEN 2: MENU PARA ENTRAR AL PROGRAMA. 

Una vez abierto el programa, aparecerá la siguiente ventana. 

 
IMAGEN 3: VISTA DEL PROGRAMA NI-MATE 2. 

De la columna de la izquierda pulsar la opción Setup. Comprobar que hay un el 
dispositivo Kinect V2 en la lista. 



 
IMAGEN 4: COMPROBACIÓN DE LA CONECTIVIDAD DEL DISPOSITIVO KINECT V2. 

En el caso que no apareciese ningún sensor, comprobar la alimentación y la conexión 
del dispositivo Kinect V2 con el ordenador (recordar que se debe de conectar en el 
USB 3.0 o superior). 

Una vez comprobado, clicar en la columna de la izquierda la flecha al lado de Kinect 
for Windows 

 
IMAGEN 5: DESPLEGAR PARA VER MÁS OPCIONES. 

Una vez desplegada las nuevas opciones, seleccionar Skeleton tracking.  

 
IMAGEN 6: SELECCIÓN DE LA CONFIGURACIÓN DESEADA. 

Una vez seleccionado, la configuración previa estará completada. Se puede cerrar 
este programa (se quedará abierto en segundo plano)  



ANEXO 2. MANUAL DE USUARIO 

1 - Acceso a la aplicación. 

Para poder utilizar la aplicación Fisiotec, en primer lugar ejecutar la aplicación. 
Aparecerá una ventana de iniciación para identificar al usuario. 

 
IMAGEN 7: ACESO A LA APLICACIÓN. 

Una vez indicado el tipo de usuario e introducido el DNI y la contraseña del usuario. 
Entrará a la aplicación. 

2 – Dentro de la aplicación. 

Para los empleados, la aplicación empezará de la siguiente forma. En el caso de los 
pacientes (ver el apartado 3 – Paciente, sección “Visualización del paciente”). 

 
IMAGEN 8: PANTALLA PRINCIPAL 

Como se puede observar, la aplicación dispone de una barra de menú con acceso a 
todas las opciones disponibles.  

El menú Administración dispone de un buscador de pacientes, un botón para reiniciar 
y un botón para salir de la aplicación. Además, la opción para ejecutar una sesión 
estará inhabilitada hasta tener abierta la sesión a ejecutar. 

En el caso de ser paciente, únicamente dispone de botón salir que reiniciará la 
aplicación y la misma función para la opción de ejecutar sesión. 



En el menú “pacientes”, “sesiones”, “ejercicios” y “empleados” disponen de tres 
opciones: Crear uno nuevo, editar y borrar. Las opciones se irán habilitando 
dependiendo de la pantalla mostrada.  

 Para crear un paciente no requiere de condición específica. 

 Para modificar y borrar un paciente, requiere visualizar la información de dicho 
paciente. 

 Para crear una sesión, requiere visualizar el panel de información del paciente 
afectado. 

 Para editar y borrar una sesión, requiere visualizar el panel de información de la 
sesión afectada o seleccionar la sesión en el panel de información del paciente. 

 Para crear un ejercicio, requiere visualizar el panel de información de la sesión 
afectada. 

 Para editar y borrar un ejercicio, requiere visualizar el panel de información del 
ejercicio afectado o seleccionar el ejercicio en el panel de información de la sesión. 

 Para crear, editar o borrar un empleado, no requiere de condición específica. 
(Nota: solo podrán crear, editar y borrar empleados los administradores) 

(Todas estas opciones descritas no están disponibles para el paciente) 

      
(A)                                                                    (B) 

                                                                                                      
(C) 

IMAGEN 9: (A) MENU ADMINISTRACIÓN DESPLEGADO, (B) MENÚ PACIENTE DESPLEGADO, (C) MENÚ 
EMPLEADO DESPLEGADO. 

  



3 – Paciente. 

La ventana para crear o modificar un paciente es la siguiente: 

 
IMAGEN 10: VENTANA PARA CREAR O MODIFICAR UN PACIENTE. 

En ella, se introducen los datos personales e información médica del paciente. Una 
vez terminada la creación o modificación, la pantalla se verá de la siguiente forma. 

 
IMAGEN 11: PANTALLA PARA VISUALIZAR LA INFORMACIÓN DE UN PACIENTE. 

En esta ventana dispone de la información del paciente, una lista de archivos adjuntos 
y de sesiones programadas/realizadas. Se pueden adjuntar ficheros desde los botones 
situados a la izquierda del cuadro de archivos adjuntos. Se pueden adjuntar cualquier 
archivo reconocible por Windows. Para poder ver un archivo, se debe de seleccionar 
en la tabla, y después pulsar el botón “Ver archivo”. El mismo caso para borrar el 
archivo.  



 
IMAGEN 12: ADJUNTAR UN ARCHIVO A UN PACIENTE. 

De igual forma, se puede gestionar las sesiones del paciente utilizando los botones a 
los lados en la tabla de sesiones. Para visualizar la sesión seleccionada en la tabla 
pulsar “Ver Sesión” (ver el apartado 4 – Sesión). Para crear una nueva sesión o 
importarla desde la plantilla, no requiere seleccionar ninguna fila de la tabla. Para 
editar, borrar y exportar una sesión, debe seleccionar en primer lugar la sesión en la 
tabla y posteriormente elegir la opción que más convenga. 

Además para tener un fácil manejo de las sesiones, la opción de ordenarlas es 
sencilla. Seleccionando la sesión a mover, pulsar los botones de la derecha (flecha 
hacia arriba o flecha hacia abajo) 

En la sección Paciente, se puede crear, editar, borrar y establecer una contraseña. 
Para establecer la contraseña del paciente el empleado, puede  asignar una 
personalizada, modificar la antigua o establecer una predeterminada (elimina la 
contraseña y se puede acceder a los datos del paciente sin ella). Esta última opción no 
está disponible para el paciente. 



       
IMAGEN 13: ESTABLECER UNA CONTRASEÑA PARA UN PACIENTE. 

Visualización del paciente. 

Para que el paciente no pueda modificar lo programado por el especialista, se le 
limitará las acciones en este visualizador. 

 
IMAGEN 14: VISTA DE LA INFORMACIÓN DE UN PACIENTE DESDE LA PESPECTIVA DEL PACIENTE. 

  



4 – Sesión. 

La ventana de sesión se muestra de la siguiente forma. 

 
IMAGEN 15: PANTALLA PARA VISUALIZAR LA INFORMACIÓN DE UNA SESIÓN. 

Datos del paciente. Se muestran sus datos para referenciar el paciente con la sesión. 

Datos de la sesión. Se muestra la información respecto a la sesión. Para crear o 
modificar una sesión, solo permite cambiar el nombre de la sesión. 

 
IMAGEN 16: CREAR/EDITAR LA INFORMACIÓN DE UNA SESIÓN. 

Tabla de ejercicios. Se muestra una tabla de los ejercicios propuestos en la sesión. 
Las opciones de crear un nuevo ejercicio, editar, borrar, importar y exportar además de 
los botones para ordenar los ejercicios son exclusivas del usuario trabajador. 



 
IMAGEN 17: VISTA DE LA INFORMACIÓN DE UNA SESIÓN DESDE LA PESPECTIVA DEL PACIENTE. 

Visualizar un ejercicio requiere seleccionar de la tabla el ejercicio a mostrar y pulsar el 
botón “Ver Ejercicio”. Este abrirá la ventana del apartado 5 – Ejercicio. 

Botón empezar sesión. Éste, lleva a una pantalla previa antes de iniciar los ejercicios 
de la sesión en el entorno 3D (Ver apartado 8 – Empezar sesión). 

5 – Ejercicio. 

En la ventana Ejercicio, se tiene acceso a toda la información respecto al ejercicio. 
“Ejercicio base” es el movimiento disponible en la aplicación 3D. Dispone de tres tipos 
de movimiento, flexión glenohumeral, abducción glenohumeral y rotación 
glenohumeral. El apartado descripción es un texto que aparecerá en la información 
previa a iniciar el ejercicio (ver en el apartado 9 – Ejecutando una sesión). 



 
IMAGEN 18: PANTALLA PARA VISUALIZAR LA INFORMACIÓN DE UN EJERCICIO. 

Visualización para crear o modificar. 

 
IMAGEN 19: CREAR/EDITAR UN EJERCICIO. 

6 – Empleado. 

Esta opción solo está disponible para los trabajadores administradores. En él, se 
puede añadir o modificar empleados. 



 
IMAGEN 20: CREAR O MODIFICAR UN EMPLEADO. 

7 – Buscador. 

El buscador dispone de diversas alternativas.  

En el caso de buscar un paciente. Éste aparecerá en forma de buscador de 
pacientes. Tiene hasta 3 campos de búsqueda con uniones lógicas. Ejemplos: 

Para buscar dos nombre distintos a la vez, en los desplegables principales 
indicar “nombre”, el desplegable de unión indicar la opción “O” y por último en 
los campos vacíos escribir un nombre (o parte del nombre) por cada campo. 
Con esto realizará una búsqueda con los dos datos de los dos campos. 

Para buscar por nombre y el primer apellido a la vez, en los desplegables 
principales indicar “nombre” y primer apellido, el desplegable de unión indicar la 
opción “Y” y por último en los campos vacíos escribir el nombre (o parte del 
nombre) en la columna del nombre y el apellido en la columna del primer 
apellido. Con esto realizará una búsqueda con los dos datos para que 
coincidan. 

 
IMAGEN 21: BUSCADOR. 

El buscador además aparecerá con la opción de importar sesión y ejercicio. 



8 – Empezar sesión. 

Una vez preparado para empezar a ejecutar una sesión, aparecerá esta ventana 
informativa antes de iniciar el entorno tridimensional. Para ello, pulsar el botón 
“Empezar” 

 
IMAGEN 22: PANTALLA ANTES DE EJECUTAR UNA SESIÓN. 

9 – Ejecutando una sesión 

Nada más empiece a ejecutarse la sesión, empezará con el primer ejercicio 
programado. Aparece la información de dicho ejercicio, un ejemplo del movimiento y 
un texto descriptivo (ver el apartado 5 – Ejercicio). Aproximadamente 10 segundos 
después empieza el ejercicio. 

 
IMAGEN 23: INFORMACIÓN PREVIA AL EJERCICIO. 

Mientras se está realizando el ejercicio, aparece el movimiento ejemplo, la duración, 
repeticiones logradas, el ángulo actual, el ángulo objetivo y en máximo logrado.  

Nota: Para conseguir realizar correctamente las repeticiones, el movimiento debe de 
pasar por el ángulo inicial y el ángulo objetivo programados. 



 
IMAGEN 24: PANTALLA DE REALIZACIÓN DEL EJERCICIO. 

Una vez terminada la sesión, volverá a la pantalla de visualización de la sesión. 

 

 

  



ANEXO 3. COMO CREAR UN FORMULARIO EN 

VISUAL C# 

Para crear un nuevo formulario, se va a suponer que ya se ha creado un proyecto 
“Aplicación de Windows Form” con lenguaje “Visual C#”. 

1: Para agregar un nuevo formulario al proyecto se selecciona en el menú Proyecto > 
Agregar Windows Form… 

 
IMAGEN 25: AGREGAR UN FORMULARIO. 

Aparece la siguiente ventana. Seleccionar Windows Form e indicar un nombre. 

 
IMAGEN 26: SELECCIONAR WINDOWS FORMS. 

  



2: Una vez agregado, familiarizarse con el entorno: 

 
IMAGEN 27: VISTA UNA VEZ AGREGADO UN FORMULARIO. 

En el centro, se encuentra el nuevo formulario que se va a crear. En él, se añadirán 
elementos visuales para controlar el programa que se está creando. 

En la sección superior de la columna de la derecha, se encuentran los elementos que 
componen el proyecto. Resaltar que un formulario contiene diversos elementos. Entre 
ellos dos ficheros .cs y un fichero .resx. Más adelante se explicará el funcionamiento 
de cada fichero. 

 
IMAGEN 28: LISTA DE OBJETOS QUE CONTIENE EL PROYECTO. 

En la esquina izquierda hay un desplegable con el nombre Cuadro de herramientas. 
En él, se dispone de elementos visuales para agregar al formulario. Ejemplo de 
botones, cuadros de texto, etiquetas, desplegables, menús y un largo etc… 



 
IMAGEN 29: LISTA DE ELEMENTOS PARA AÑADIR EN UN FORMULARIO. 

Como se ve en la siguiente imagen, se han agregado distintos elementos al formulario. 

 
IMAGEN 30: ELEMENTOS AGREGADOS. 

Esta barra de herramientas ayuda a la colocación de los diferentes elementos dentro 
del formulario. 

 
IMAGEN 31: BARRA DE HERRAMIENTAS PARA ORDENAR LOS OBJETOS EN UN FORMULARIO. 

En la sección inferior de la columna de la derecha, se encuentran las propiedades del 
elemento seleccionado. En la siguiente imagen (imagen 75) se puede observar las 
propiedades de un botón. Destacar varias propiedades: Font, modifica la fuente del 
texto interior del botón; Text, modifica el texto interior; Enable, habilita o deshabilita el 
funcionamiento; (Name), asigna un nombre al elemento para poderlo utilizar en código; 
Size, modifica el tamaño. 



 
IMAGEN 32: PROPIEDADES DE UN OBJETO BOTÓN. 

3: Se va a explicar los distintos elementos que compone un formulario.  

Visual Studio trabaja con los formulario en C# con clases parciales. Con esto, puede 
haber distintos ficheros que son una misma clase. Un formulario es una clase, por 
tanto, para que sea sencillo su elaboración con elementos visuales, una parte de la 
clase serán los elementos visuales y otra parte de la clase será las funciones. En 
siguiente imagen (imagen 33) se muestra los elementos de un formulario llamado 
“formLogin”.  

 
IMAGEN 33: DISTINTAS PESTAÑAS DEL MISMO FORMULARIO. 

Éste, tiene un elemento llamado “formLogin.cs [Diseño]”. Este elemento es el 
formulario visual, donde se agregan los botones, cuadros de textos y demás 
elementos. Cuando esta parte visual es modificada, en realidad quien se modifica 
automáticamente es el fichero con nombre “formLogin.Designer.cs”. Este archivo .cs 
contiene las propiedades de todos los elementos visuales. El fichero con el nombre 
“formLogin.cs”, contiene todas las funciones y ejecuciones de los elementos del 
formulario (ver siguiente apartado). Por último el fichero con nombre “formLogin.resx” 
contiene los recursos externo e internos que pueden ser agregados al formulario. Por 
ejemplo una imagen, un video, una cadena de texto… 

4: Una vez terminado el diseño visual del formulario es hora de preparar las funciones 
de cada elemento.  



 
IMAGEN 34: FORMULARIO DISEÑADO VISUALMENTE. 

Cada tipo de elemento dispone de diversas formas de utilizarse. Por ejemplo, para un 
cuadro de texto, por defecto, se crea una función que detecta cada vez que se hace un 
cambio en el texto interno del cuadro. Además, también dispone de funciones que 
detecten una pulsación de teclado específico, o una pulsación con el ratón.  

Haciendo doble clic sobre el elemento para el que se quiere definir una función, se 
crea una función predeterminada y se entra en la ventana de programación. Un 
ejemplo, clicar sobre un botón denominado „Salir‟. 

 
IMAGEN 35: CODIGO QUE REALIZA LA FUNCIÓN DE SALIR DE LA APLICACIÓN. 

Una vez creada la función, se escribe la línea que realice la salida de la aplicación. 

5: Para finalizar, una vez terminado de crear todas las funciones, es momento de 
probar la aplicación. 

 
IMAGEN 36: INICIAR EL DEPURADO. 

Con esto se inicia la depuración de la aplicación pudiendo probar el funcionamiento de 
éste. Se puede incluso introducir marcas específicas para que pause la ejecución de la 
aplicación y poder ver línea a línea que se está ejecutando. 



 
IMAGEN 37: EJECUCIÓN DEL DEPURADO. 

  



ANEXO 4. COMO CREAR UNA APLICACIÓN EN 

BLENDER 

Blender es una herramienta de modelismo tridimensional. Con él, se pueden crear 
modelos en tres dimensiones para ser utilizados. Además dispone de funciones de 
renderizado para crear animaciones y otra función para realizar juegos. Cada función 
descrita utiliza un motor de renderizado específico. 

En este caso se va a explicar cómo realizar una aplicación de un avatar que mueva un 
brazo controlado a través del dispositivo Kinect V2. 

 
IMAGEN 38: PANTALLA INICIAL DE BLENDER. 

1: En primer lugar se configura Blender.  Se cambia el motor de renderizado de 
Blender Render a Blender Game. 

 
IMAGEN 39: DISTINTOS MOTORES DE RENDERIZADO. 

Se necesita tener instalado el plug-in de Ni-Mate
1
. Se instala a través de User 

Preferences > Addons  y el botón “Install from file”. Buscar el archivo .py descargado 
de la web de Ni-mate y comprobar que posteriormente esté activado. 

                                                
1 ni-mate.com 

https://ni-mate.com/download/


 
IMAGEN 40: ACCEDER A LAS PREFERENCIAS. 

Una vez terminada la instalación, aparecerá en la barra de la izquierda, una pestaña 
llamada “Ni ma”, si se clica, se verán estas opciones. 

 
IMAGEN 41: PESTAÑA DE CONFIGURACIÓN DE NI-MATE EN BLENDER. 

Para crear por primera vez los elementos que realizarán los movimientos del usuario a 
través del dispositivo Kinect V2, se debe de activar la opción Empty y luego pulsar 
Start. Nota: la herramienta Ni-mate debe de estar en funcionamiento y configurada 
correctamente.  

 
IMAGEN 42: CREAR "EMPTIES" CUANDO SE CONECTE BLENDER CON NI-MATE. 

Aparecerá un Empty de cada articulación que pueda detectar el dispositivo Kinect V2. 
A partir de aquí ya se puede empezar a realizar la aplicación. 



 
IMAGEN 43: VISTA DE LOS "EMPTIES" DE LAS ARTICULACIONES DE UN USUARIO DELANTE DEL 

DISPOSITIVO KINECT V2. 

2: Es momento de realizar o importar un avatar. En este caso se explica cómo importar 
un elemento tridimensional. Blender dispone por defecto de varias opciones para 
importar elementos externos. Se pueden activar e instalar más opciones a través de 
los addons.  

Se busca un avatar a través de internet y se descarga. Una vez conocido el formato 
del fichero descargado se va a File > Import  y se selecciona el tipo de fichero 
descargado. Se abrirá un navegador donde se buscará el fichero en cuestión y se 
importará. Una vez importado aparecerá en la escena. 

 
IMAGEN 44: AVATAR MASCULINO. 

Una vez importado, es momento para conectar un esqueleto con el avatar. Para eso 
se inserta un esqueleto a través de los botones Add > Armature > Human. 



  
IMAGEN 45: CREAR ESQUELETO. 

Aparecerá un esqueleto el cual se debe de acoplar con el avatar importado.  

Se tiene que ir con mucho cuidado para colocar cada hueso en su lugar correcto. Una 
vez terminado el trabajo laborioso se verá parecido a esto. 

 
IMAGEN 46: COLOCAR EL ESQUELETO CON LA MALLA DEL AVATAR. 

Es hora de unir los dos elementos. Para ello seleccionar primero al avatar y pulsando 
la tecla mayúscula se selecciona el esqueleto. Se pulsa Control + P y aparecerá una 
menú emergente. Seleccionar “Armature Deform with Automatic Weights”. 



 
IMAGEN 47: REALIZAR PARENTESCO ENTRE EL AVATAR Y EL ESQUELETO. 

Blender une de forma automática cada hueso con las vértices más cercanas y degrada 
el efecto cuanto más alejado esté. De todas formas se puede modificar de forma 
manual. 

3: Al ser Blender una herramienta con muchas opciones para trabajar, dispone por 
defecto diversas formas de ver y trabajar con él. En este apartado se va a crear la 
animación para que el avatar se mueva y por tanto se va a seleccionar su forma de 
trabajar para la animación. Para ello se selecciona “Animation”. 

 
IMAGEN 48: CAMBIO DE ESTILO DE VENTANA. 

Blender cambiará la visualización de su ventana para tener más accesible las 
opciones que se utilizan para realizar la animación. Como ya está asignado el 
esqueleto al avatar, se selecciona los huesos involucrados en el movimiento. Si hace 
falta para tener mejor visionado de los huesos, se puede ocultar el avatar. En primer 
lugar se selecciona el hueso del antebrazo. Para tener una referencia más certera, 
inicialmente se colocará apuntando perfectamente hacia el suelo. Se comprueba que 
en la barra de tiempos se encuentre en el frame 0. Con el ratón encima de las 
opciones de rotación del hueso, pulsar la tecla “I” del teclado y marcará de color 
amarillo. Esto significa que se ha creado una clave en el frame 0 con los ángulos 
indicados. 



 
IMAGEN 49: VISTA DE BLENDER CON LA VENTANA ESPECIALIZADA PARA ANIMACIÓN. 

El siguiente paso es colocar el brazo horizontalmente y en la barra de tiempos colocar 
el cursor en el frame 90. Realizar el mismo paso con el ratón encima de la rotación y 
pulsando la tecla “I” del teclado. En la siguiente sección se verá de la siguiente forma:  

 
IMAGEN 50: EDITOR GRÁFICO. 

Este es el movimiento que realizará el brazo. Como no es el que se desea, con el 
ratón encima del gráfico, pulsar la tecla “A” para seleccionar todos los elementos de la 
gráfica y después pulsar la tecla “T”. En él se selecciona la opción lineal. Ahora, el 
movimiento es lineal y por tanto corresponde los grados con los frames. Además si 
supera por encima o por debajo entre 0 y 90 frames, la animación realiza una 
interpolación del movimiento moviendo de más. 

Comprobar en la siguiente sección de la ventana si la animación se ha creado 
correctamente. Se puede modificar el nombre de la animación para un mejor 
entendimiento. 



 
IMAGEN 51: HOJA DE INFORMACIÓN DE LAS ANIMACIONES. 

4: Ahora toca programar. Blender utiliza el lenguaje Python. Para ello, seleccionar 
“Game logic” para que cambie la ventana a una forma de programación de juegos. 

 
IMAGEN 52: CAMBIO DE ESTILO DE VENTANA. 

Desde esta vista, se dispone de los diferentes elementos de programación. En la caja 
inferior las “Logic Bricks”, a la derecha superior las líneas de comando.  



 
IMAGEN 53: VISTA DE BLENDER CON LA VENTANA ESPECIAL PARA PROGRAMACIÓN DE EJECUCIONES. 

En primer lugar para aplicar el movimiento al avatar se selecciona el esqueleto. Con 
las “Logics Bricks” se añade un “Always” de sensor con un “Armature” en los 
actuadores. Además añadir otro “Always” en modo pulso unido a un controlador 
Python. En él se selecciona “module” y se escribe: 
animation_delicode_ni_mate_tools.updateGE. Además se añaden las siguientes 
propiedades. 

 
IMAGEN 54: LISTA DE PROPIEDADES DE UN OBJETO. 

Nota: Blender una vez creado y ejecutado el módulo de Ni-Mate, pre-configura estos 
elementos necesarios para el correcto funcionamiento. En el caso de que no estén, 
hay que crearlos. 

Añadir además en las “Logic Bricks” otro controlador Python unido al “Always” modo 
pulso y un “Action” de actuador unido a este controlador. De esta forma las líneas de 
código que se creen controlarán al actuador que esté unido a él. Añadir una propiedad 
donde se almacenará el valor del ángulo para la animación. 

En el actuador “Action” se configurará con la animación creada del movimiento del 
avatar. 



 
IMAGEN 55: CONFIGURACIÓN DE UN ACTUADOR. 

De esta forma, se puede controlar la animación mediante la modificación directamente 
del frame a mostrar. 

5: Para el código se va a tener en cuenta la siguiente sugerencia. Blender ejecuta 
completamente todas las líneas de código asignadas a cada elemento del escenario 
en cada frame que se ejecute la aplicación. Por ello tener en cuenta no crear bucles de 
ejecución lenta ya que hasta no finalizar dicho bucle no cambiará al siguiente frame. 

En primer lugar hay que importar las librerías necesarias para el funcionamiento del 
código. 

 
IMAGEN 56: LÍNEA DE CODIGO PARA IMPORTAR LAS LIBRERIAS. 

Obtener la escena, la controladora de los “Logic Bricks” y las propiedades del objeto. 

 
IMAGEN 57: OBTENER LA INFORMACIÓN DEL ESCENARIO, DE LOS "LOGIC BRICK'S" ASOCIADOS Y DE LAS 

PROPIEDADES DEL OBJETO. 

Mediante la escena, obtener los objetos que son controlados por el dispositivo Kinect 
V2 para conocer su ubicación. 

 
IMAGEN 58: ASIGNAR A VARIABLES LOS OBJETOS DE LA ESCENA. 

Una vez que se obtienen estos objetos se realiza el cálculo matemático para obtener 
el ángulo del antebrazo. Como Blender trabaja en radianes y los frames representan 
los ángulos en grados, se realiza una conversión y se asigna a la propiedad. Recordar 
que esta propiedad está asignada al control de la animación. 



 
IMAGEN 59: CÓDIGO PARA REALIZAR EL CÁLCULO DEL ÁNGULO DE DOS  VECTORES. 

Añadir también la función para activar la animación. 

 
IMAGEN 60: CÓDIGO PARA ACTIVAR ANIMACIÓN. 

6: Una vez terminado todo, colocar el ratón encima de la ventana 3D, pulsar la tecla 
“P”. Esto activará la ejecución y prueba de la aplicación. 

7: Por último, para crear un ejecutable, ir a File > Export > Save as Game Engine 
Runtime. Seleccionar la carpeta y el nombre del fichero ejecutable. 



 
IMAGEN 61: EXPORTAR LA APLICACIÓN A UN EJECUTABLE. 

Una vez terminado la ejecución de exportar, habrá un archivo ejecutable y una carpeta 
con ficheros necesarios para el funcionamiento de la aplicación. 

  



ANEXO 5. COMO CREAR UNA ANIMACIÓN EN 

BLENDER 

Una animación es la reproducción de muchas imágenes consecutivas en un intervalo 
de tiempo corto. Para una herramienta de creación de elementos 3D no varía su 
significado.  

En este ejemplo se va hacer una animación de un cubo que realiza rotaciones a sí 
mismo. 

Primero se va a crear un objeto, en este caso un cubo. 

 
IMAGEN 62: AÑADIR UN CUBO EN EL ENTORNO TRIDIMENSIONAL EN BLENDER. 

Se cambia la ventana a modo “Animation”. En el desplegable superior  

 
IMAGEN 63: CAMBIAR EL FORMATO DE VISUALIZACIÓN EN BLENDER. 

  



Se comprueba que el cursor en la barra de tiempo se encuentra en el frame 0. 

 
IMAGEN 64: COMPROBACIÓN DE LA BARRA TEMPORAL. 

Se selecciona el cubo y se va a la herramienta editor de objeto 

 
IMAGEN 65: OBTENER LAS PROPIEDADES DE UN OBJETO. 

Con el ratón encima de la propiedad rotación se pulsa la tecla “I” del teclado. Esto hará 
que cambie de color. 

 
IMAGEN 66: CREAR UNA CLAVE EN LA PROPIEDAD ROTACIÓN EN UN FRAME ESPECÍFICO. 

Esto crea una clave en el frame 0 obligando a que se encuentre en estos valores 
siempre que se reproduzca este frame.  

Ahora seleccionar otro frame en la barra de tiempo por ejemplo el frame 60. 



 
IMAGEN 67: CAMBIO DE FRAME EN LA BARRA DE TIEMPO. 

Se introduce manualmente los valores Y = 90º y z = 180º en la propiedad rotación. 

 
IMAGEN 68: MODIFICAR EL VALOR DE UNA PROPIEDAD QUE DISPONE DE UNA CLAVE EN ALGÚN FRAME. 

Con el ratón encima de esta propiedad pulsar de nuevo la tecla “I” y se marcará otra 
clave. 

 
IMAGEN 69: VISTA DEL EDITOR GRÁFICO. 

Se puede observar en el editor gráfico (la imagen superior) como la propiedad de 
rotación Y y Z (verde y azul respectivamente) realicen un cambio de valor en el tiempo. 

Se puede realizar interpolaciones con el ratón encima de la gráfica y pulsando la tecla 
“T” del teclado o en el menú desplegable Key. 



 
IMAGEN 70: DENTRO DEL MENÚ KEY PARA INTERPOLAR LOS VALORES DE LA GRÁFICA. 

Por ejemplo se va a realizar una interpolación lineal. De esta forma la gráfica cambia y 
el movimiento de la animación también. 

 
IMAGEN 71: VALORES INTERPOLADOS. 

Ahora pulsar el botón “play” y se verá el movimiento del cubo. 

  



ANEXO 6. INSTALAR EL PLUG-IN DE NI-MATE EN 

BLENDER 

 

En primer lugar descargar2 de la web de Ni-Mate la versión para Blender. 

 
IMAGEN 72: DESCARGAR LA VERSIÓN DE BLENDER. 

Una vez descargado, abrir Blender y acceder a File > User Preferences 

 
IMAGEN 73: ENTRAR A USER PREFERENCES. 

 

 

                                                
2 https://ni-mate.com/download/ 

https://ni-mate.com/download/


Dentro de las preferencias, acceder a Addons y pulsar el botón Instal from File… 

 
IMAGEN 74: PESTAÑA ADDONS 

Buscar el archivo descargado recientemente con la extensión “.py” y pulsar instalar. 

 

 
IMAGEN 75: INSTALAR A TRAVES DE FICHERO. 

Una vez de vuelta a la ventana Addons seleccionar de la columna de la izquierda la 
pestaña “Animation” y comprobar que la animación Delicode Ni mate Tools esté 
habilitada. Si no lo está, habilitarla. 



 
IMAGEN 76: COMPROBAR Y HABILITAR LA FUNCIÓN. 

 

Cerrar la ventana User preferences, y acceder a la columna de la izquierda a la 
pestaña con nombre Ni ma. En ella se ven las siguientes opciones. 

                                                                    . 

 

 

Recepción de la información. Asocia los 
objetos de la escena con nombres específicos 
con los nombres de las articulaciones. Si no 
existen los objetos se pueden crear Empties, 
Esferas y Cubos. Después pulsar Start. 

Sección para ser utilizado con el motor de 
renderizado “Blender Game”. Para añadir las 
propiedades y scripts específicos, mientras 
esta seleccionado el esqueleto, clicar “Create 
game logic”. 


